
 HyperSnap    Contents    

      Overview a good place to start with items of special interest to all, especially to 
Web and Help authors

      Tutorial a step-by-step lesson on how to capture, edit, and save a screen shot

      QuickHelp a hypertext image map of all HyperSnap's menu items -- the quickest 
way for users get the answer to a question. Also accessible from the 
QuickHelp button above.

      QuickReference a list of each HyperSnap command, with a hypertext explanation only 
a click away. Also accessible from the QuickRef button above.

      Tips & Hints suggestions for the best use of the program and how to make those 
difficult captures.

      Beta tester tale git up here on the porch and set a spell, and Come and listen to a 
story 'bout a man named Zed. . . 

      Support troubleshooting, and how to contact the author for technical support

      Registration how to purchase HyperSnap

 Software by Greg Kochaniak
Hyperionics Logo and WEB pages designed by Catch Web Design
(http://www.xs4all.nl/~catch/design.html).    Thank you, Beert!



 HyperSnap  Feature Overview

HyperSnap brings professional quality, convenient Windows 95 and NT screen captures to your 
fingertips. It was designed for ease of use, with powerful and useful features to aid the professional as 
well as support the needs of the occasional user. Use it just a few times -- you'll find it to be 
indispensable.

HyperSnap was selected by Siemens Nixdorf as a standard software component distributed with their 
powerful CELSIUS personal workstations!

Click on any of the buttons or help hotspots below to learn more about the HyperSnap feature 
mentioned.    

    Save your image as a BMP, GIF, or JPEG file. GIFs can optionally be interlaced and include 
transparent backgrounds, and HyperSnap can create progressive JPEGs, perfect for World Wide Web 
page use. Choose your color depth for BMP captures, too.

    Web Authors, don't miss what HyperSnap can do for you!
    Help File creators will love some of these special HyperSnap options.
    Include the cursor image in your capture for a special look few capture programs can bring to you.
    The flexible and labor-saving Window capture option captures whole windows and smaller sections

of windows, highlighting the boundries of each of your options, to make a quick and accurate capture 
without eyestrain and further editing. 

    Choose your own HotKeys that quickly capture the entire Desktop, any Rectangle you outline, or 
the highlighted Window or Client, and automatically repeat the capture every x seconds or by using 
another HotKey.

    Automatically save each of your captures to a file by default -- you can even trigger new captures
every x seconds and have the filename incremented.

    Print your capture direct from HyperSnap -- it will expand the image to the size of the paper and 
margins that you set, and even add a frame, reverse, or reduce the output to black and white!

    Drag and Drop BMP, GIF, and JPEG files on HyperSnap to open them!

HyperSnap is marketed using the shareware method of distribution. After a reasonable period of time to 
"try before you buy" (a maximum of thirty days is suggested as appropriate), you must purchase this 
software to continue to use it legally. It must otherwise be removed from your machine. Purchase 
information can be found under Registration.

 QuickHelp displays an image of all the menu options that you can click for explanations of their 
use. 

 QuickReference is an alphabetical listing of the same menu items.
 The HyperSnap Tutorial can be a great way to get to know HyperSnap



 HyperSnap    for Web Authors
Web Authors will be especially interested in HyperSnap's convenient GIF and JPEG save options. Click 
on any of the buttons or help hotspots below to learn more about the HyperSnap feature mentioned.

    GIF images can be saved as interlaced files, with transparent backgrounds, and three levels of 
color reduction.

    JPEGs have save options for a user-defined percentage of output quality, and the "fade-in" 
format.

    The Quick Save feature is a lifesaver -- just keep on making those captures, without 
interruption. HyperSnap saves them each to an individual, sequentially named GIF or JPEG file, in 
the custom format you choose, for your later review and use.

    Include the cursor image in your Web Page image to better display your product shot or call 
attention to a specific item.

    The Window capture feature makes my day. The feature captures whole windows and sections 
of windows that are automatically highlighted, even little buttons, without squinting at the screen to 
make sure you get every pixel of the edge of a capture target. A definite eye-saver.

    The built-in Crop feature is great for making final edits to your capture without transferring it to
another program. And thankfully, there's an Undo Crop feature to mitigate the "oops!" factor.

There's so much more... just use HyperSnap. It will become your tool of choice.

 Back to Feature Overview
 QuickHelp



 HyperSnap  for Help Authors
Help File creators will love some of the convenient capture and editing features HyperSnap offers. Click 
on any of the buttons or help hotspots below to learn more about the HyperSnap feature mentioned.

    Include the cursor image in your Help file image to better illustrate your point or call attention to a 
specific item.

    The Quick Save feature is a lifesaver -- just keep on making those captures, without 
interruption. HyperSnap saves them each to an individual, sequentially named file in the color density 
you choose, for your later review and use.

    Bitmap Copy Options doesn't just perform the handy task of sending screen captures to the 
clipboard -- it sends them in the color mode you preselect. Even if you're in True Color, you can send 
16 color captures to the clipboard. Very handy for those Win 3.1 help files!

    The Window capture feature makes my day. The feature captures whole windows and sections 
of windows that are automatically highlighted, even little buttons, without squinting at the screen to 
make sure you get every pixel of the edge of a capture target. A definite eye-saver.

    The built-in Crop feature is great for making final edits to your capture without transferring it to
another program. And thankfully, there's an Undo Crop feature to mitigate the "oops!" factor.

There's so much more... just use HyperSnap. It will become your tool of choice.

 Back to Feature Overview
 QuickHelp



 HyperSnap    QuickHelp
This graphic will conveniently tell 
you everything you need to know 
about HyperSnap's many features.

It serves as both as a quick 
introduction to all HyperSnap    can 
do to make screen captures easier, 
as well as an ongoing reference 
when it is required.

Each drop-down menu is included 
here. Simply click on any menu 
selection for a complete explanation
of the function it accesses.

 There's more to HyperSnap than 
meets the eye. Be sure to check out
each menu item to find some of the 
most useful features.

 Special Features Page



 HyperSnap QuickReference
Click on any command for a quick explanation of its function.

Bitmap Copy Options Quick Copy

Clear Quick Print

Configure Hot Keys Quick Save

Copy Region (Capture)

Copy Format Registration

Crop Repeat Last Capture

Enter License Number Restore After Capture

Full Screen (Capture) Save BMP

Hide Help in Region Capture Save GIF

Include Cursor Image Save JPEG

Open Save Options

Paste Technical Support

Page Setup Undo Crop

Print/Print Setup Window (Capture)

Open
Open a GIF, BMP, or JPEG file.

You can also open these file formats 
simply by dragging and dropping a file 
to HyperSnap or specifying a filename
in a command line.



Save As
Save As opens the standard
Windows Save dialog. Click
on the Save File As Type to
choose from BMP, GIF, or
JPEG file formats.



Save BMP
Select your file format from the standard Windows save dialog,
and then choose your target directory. Click on Options to
select from additional BMP format choices:

Normally, you will want to leave Auto select checked to
save your capture in the current display mode. However, you
can select from Monochrome, 16, 256, or 16 million colors by
deselecting Auto select and clicking on any other choice. Your 
choice is saved between sessions.



Save Options
Click here to open the "Save Options"
dialog. It will let you set options specific
to currently selected picture format.



Save GIF
Select your file format from the standard Windows save dialog, and then choose your target directory. 
Click on Options to select from additional GIF format choices:

Interlaced, to "fade in" when used on 
the World Wide Web

Transparent Background, to allow 
your background color or bitmap to 
display behind your graphic when used
on the World Wide Web

Color reduction may be necessary 
since the standard GIF format only 
supports 256 colors. HyperSnap lets 
you choose from three options:

      - fastest: match in standard, 
balanced colormap
      - medium: optimize colormap
      - slowest, but the best quality: 
optimize colormap and dither

If the image you loaded or captured 
has 256 or less colors, these options 
are disabled..



Save JPEG
Select your file format from the standard Windows
save dialog, and then choose your target directory.
Click on Options to select from additional JPEG 
format choices:

You may choose an output quality factor to reduce 
the size of your capture file. We recommend 75%
as a good place to start, but you may wish to 
experiment.

JPEG files can be saved in the new progressive 
format for World Wide Web use. This means they 
will appear in their entirety, and then sharpen from 
their original fuzzy appearance. Not all web browsers
support this new standard.



Print/Print Setup
Selecting Print or Print Setup
will provide the familiar Windows 
dialogs.



Page Setup
Choose from several custom setup options that will apply when you print your capture.

Invert Black & White is a 
great option for creating 
negative transparencies of 
screen shots -- saves on 
toner, too, if your capture 
has lots of dark areas.

Black and White Only 
eliminates greyscales for a
cleaner look in some 
instances.

Draw Frame adds a thin 
line frame around the 
image for that finished 
look.

Specify Margins in inches, cm, or mm measurements for all four sides of your captured image. 

Orientation lets you choose from Portrait, Landscape, or let HyperSnap select the best fit.

Scaling offers the option to scale to a specific percentage more or less than the original, or let HyperSnap
Auto-fit the image to fill the page within your specified margins. Use Printer Resolution will cause your 
printer resolution to affect the output; i.e., if you were to choose a scaling factor of 100%, the bitmap will 
have the same number of printer pixels up and down as it had on your screen.



Copy
Copy the current capture to the
Windows clipboard



Paste
Paste the contents of the Windows
clipboard into HyperSnap.



Clear
Clear the current capture
from HyperSnap.



Full Screen (Capture)
Click to capture the entire desktop (all you can see on the screen)

 Configure Hot Keys



Region (Capture)
When clicked, a large cross cursor (+) will appear.

Click using your left mouse button to indicate where you want to start the capture area, and then release 
it. Drag the outline to enclose the area you want to capture, and click the mouse button again. The size (in
pixels) of the capture will be shown within the area.

While activated, the following additional useful options apply, and will be shown in a small window as a 
reminder. They can be toggled off using F1 or by the option: Hide Help in Region Capture.

USE MOUSE OR THE FOLLOWING KEYS:
F1: hide/show this help
Arrows: more pointer by one pixel
Shift-Arrows: move pointer by 5 pixels
Ctrl-Arrows: move pointer by 20 pixels
Esc or Right Button: abort operation
Enter or Left Button: accept this position
+: hide/show mouse pointer

once the first anchor point is established, these tips are added:
-: hide/show rectangle size in pixels
Tab or Home: switch rectangle corner

 Configure Hot Keys



Window (Capture)
When clicked, a cross cursor (+) will appear. As you move your mouse 
around, a blinking frame will appear around the target object.

Move to the Window you want to capture, and click with your left mouse 
button to select and capture the region around which the blinking frame 
surrounds.

Click your right mouse button to abort this function.

 As you maneuver for your capture, if the highlight 
includes only a sub-window within a window you want to capture, try 
clicking on its title bar or frame

 Configure Hot Keys



Configure Hot Keys
Hot Keys is a convenient feature of HyperSnap. Even when minimized, the program stands ready to 
accept your hot key combination to immediately capture a screen! The Hot Keys (keyboard shortcuts) for 
screen captures can easily be customized to your preference.

Assign takes your keyboard 
input and assigns it to the 
highlighted function
Remove deletes the Assigned 
Key (Hot Keys)
Clear All deletes all Assigned 
Keys (Hot Keys)
Defaults returns all Assigned 
Keys to their original states
Revert returns all Assigned 
Keys to the assignments that 
were in effect when you 
opened the dialog
Enable hot-keys turns the 
function on and off

Highlight the function you wish to change, and then locate your cursor in the "Press the key combination" 
box. Execute the key combination you want for that function, and then click on Assign. Your new Hot Key 
assignment will also be shown in the HyperSnap menu option.

 Be sure not to assign Hot Key combinations that might conflict with another program. To prevent any 
problems with specific programs, you can temporarily disable HyperSnap's hot keys in the dialog shown 
above.

 Repeat Last Capture
 Quick Save for information on Stop Auto Capture



Hide Help in Region Capture
When checked, this option hides the "help box" that 
appears during a Region Capture. It can be viewed
by toggling it using the F1 key.

 Region (Capture)



Copy Format / Bitmap Copy Options
This option affects the number of colors of the bitmap pasted
to the Windows Clipboard when you use the Quick Copy
function. 

You may want to leave Auto select checked to save your 
capture in the current display mode. However, you can 
select from Monochrome, 16, 256, or 16 million colors by
deselecting Auto select and clicking on any other choice.
Your choice is saved between sessions.

 This option can save you steps if you are
in a higher color mode, like True Color or just 256 colors,
yet want to paste a bitmap into a document using the less
space-consuming 16 color or other color mode.

 Quick Copy



Quick Copy
Click this option to automatically have your capture sent to
the Windows Clipboard

 Copy Format



Quick Print
Quick Print automatically sends your capture to your printer.
The options selected in the Page Setup dialog will affect the
output.

 Page Setup



Quick Save
Quick Save, when selected (check mark appears next to option), will automatically save your capture as a
BMP, GIF, or JPEG file. The dialog appears when you check off the option.

You can specify a file name or leave the "Save to:" box blank to be prompted for a file name after each 
capture. Check Increment file name and HyperSnap will save the files to the file name you choose, 
incrementing the number within the range you specify in the "start at" and "stop at" blocks.

If you enter a number (other than zero) in the Repeat first capture every [      ] seconds, and check the 
Quick Save option under the Capture menu, HyperSnap will automatically save a screen capture until you
tell it to stop, using the "Stop Auto Capture" hot key. If you change the area that you are capturing without 
stopping Auto Save, it automatically switches to capturing the newly defined area.

 These HyperSnap functions are great for producing graphics for manuals or other instructional 
materials, to show and teach a series of steps within a program window. Include the cursor for extra 
emphasis on specific areas.

 Configure Hot Keys



Restore After Capture
When this option is checked, HyperSnap will automatically restore itself to view after a capture, whether it 
is open or iconized.

If you uncheck the Restore after Capture option, the HyperSnap window will remain or become minimized
(stay in the task bar) after the snapshot.

 Sometimes you'll find it very handy to keep HyperSnap minimized in the task bar. You may start your 
snapshots by clicking with the right mouse button on a minimized HyperSnap window or by using hot 
keys, so it will print or copy images instantly.



Crop / Undo Crop
Once you have captured or opened an image, you can crop it within HyperSnap. When selected, a large 
cross cursor (+) will appear and cover the entire HyperSnap window.

Click using your left mouse button to indicate where you want to start the capture area, and then release 
it. Drag the outline to enclose the area you want to capture, and click the mouse button again. The size (in
pixels) of the capture will be shown within the area.

While activated, the following additional useful options apply, and will be shown in a small window as a 
reminder. They can be toggled off using F1 or by the option: Hide Help in Region Capture.

Shift-Arrows: move pointer by 5 pixels
Ctrl-Arrows: move pointer by 20 pixels
Esc or Right Button: abort operation
Enter or Left Button: accept this position
+: hide/show mouse pointer

once the first anchor point is established, these tips are added:
-: hide/show rectangle size in pixels
Tab or Home: switch rectangle corner

Undo Crop
Making this selection from the Edit menu will return the capture or graphic to its pre-crop state.



Include Cursor Image
You may optionally include the image of your 
current cursor in your capture.

 Use the cursor to highlight a point of 
interest in your capture. HyperSnap can 
capture some cursors that were previously
thought invisible to all such programs. Due to 
non-standard ways in which cursors are 
handled by some programs, some custom 
cursors simply cannot be captured. 

In Windows 95, the standard set of cursors is 
captured, as well as those defined by applications. 
In Windows NT, the cursor shape may be 
incorrect if it is within the console (DOS Prompt) 
window.



Repeat Last Capture
Use this menu item or Hot Key to quickly
repeat the last capture executed.

 This is a handy feature to take sequential
or instructional captures of the same area,
or redo the last capture with a minor change.

 Configure Hot Keys



Enter License Number
When you register HyperSnap, you will receive a license number to enter in this dialog. It will immediately 
remove all of the registration messages as well as enable some additional, helpful features that are 
unavailable in the shareware version as an incentive for users to register the program.

To complete the dialog and register the program, 

click on the dot alongside the type of license you have purchased 
enter the registration name exactly as it is provided in the registration document*
key in the license number that was provided
enter the number of licensed copies

If you have not yet registered, click on Cancel. We have provided a convenient registration form 
accessible from the option in the Help menu in the program.

 *If the registration name is not as requested or misspelled, please contact us promptly.



 HyperSnap    Support
Troubleshooting Tips:

Sometimes, particularly on slower machines, a computer may not have enough time to refresh all the
windows when you start the capture, and the HyperSnap window disappears. In 32 bit environment 
applications are isolated from each other, and it's not possible to find out if all the windows are 
correctly refreshed. They are given only a limited time for the refresh, before HyperSnap freezes the 
screen for the capture. If this happens, minimize the program window to the task bar first, and then 
start your capture with a hot key or the menu that pops up when you click using your mouse right 
button on the task bar.

If you are in High Color mode (16 bits per pixel, 65K colors) or True Color (24 to 32 bits per pixel, 
16M colors) and you're not satisfied with the quality of colors in GIF files, go to GIF options dialog 
from the Save As selection under the File menu item. Select "Optimize colormap" or "Optimize 
colormap and dither" option. Then make the same capture and save the GIF file again. The resulting 
colors should be much better.

Support for HyperSnap is close at hand. An e-mail message will get the quickest response. Be certain 
to provide as much background information as possible.

We also welcome your comments and input for future releases of HyperSnap.

e-mail: gregko@kagi.com

Greg Kochaniak
Hyperionics
3146 Chestnut Street
Murrysville, PA 15668, USA

Check our World Wide Web site for the latest releases, announcements, and more information about 
HyperSnap:        http://198.207.242.3/authors/gregko/gregko.htm



 HyperSnap    Registration
Register your copy of HyperSnap by selecting "Register" on the button bar above, or from within the help 
menu. This program is a 'try before you buy' shareware program that relies on your support for continued 
development, and single user registration is only $20.00. When you register HyperSnap you will receive 
a code that enables additional features and become eligible for priority support. You will also be able to 
obtain free updates of the program through our Web page (address below) with which you can use your 
registration code, until the next major release.

To register copies of HyperSnap, please use the "Register" program usually provided with HyperSnap to 
make payments. You can click on "Registration" in the button bar above to access it. We use KAGI 
SHAREWARE registration service, which accepts different payment methods, including credit card and 
invoices. You may also mail your check or money order written in US currency only, directly to the 
address below, payable to Greg Kochaniak.

Greg Kochaniak
Hyperionics
3146 Chestnut Street
Murrysville, PA 15668, USA

e-mail: gregko@kagi.com
http://www.kagi.com/authors/gregko/gregko.htm

                
License cost:

Single licenses: $20 each
Site license: $500 
(Site licenses cover a single organization for an area of up to one hundred miles (160 km) in 

radius.)
World-wide license:    $1500

HyperSnap may be also registered using CompuServe SWREG forum (GO SWREG). The Registration 
Id. is 9878. The price for single user license over CompuServe is $22 due to the 15% charge they 
impose. The latest version of HyperSnap may be usually downloaded from CompuServe WINUTIL forum, 
library 9 Windows 95.



 HyperSnap    and Siemens Nixdorf

CELSIUS: The new Personal Workstation from Siemens Nixdorf

The area of professional desktop systems is changing dramatically. While in the past traditional 
workstations were the only powerful alternative, nowadays high-end PC-based systems are the choice.

CELSIUS is the new personal workstation series of Siemens Nixdorf blending the power of a workstation 
with the economy, universality, and future of a PC. Pentium Pro Processor, high speed PCI bus system, 
and the new 3D processor GLINT 300SX form the base for CELSIUS performance targeting the 
workstation area. Windows NT, the state of the art and new standard operating system for workstations, 
gives CELSIUS an overall functionality.

HyperSnap was selected by Siemens Nixdorf as a standard software component distributed with their 
powerful CELSIUS personal workstations.

For more information send electronic mail to celsjus@mch.sni.de or visit the WWW page at 
http://www.sni.de/public/aswwis/visual/welcome.htm



 HyperSnap  Tutorial

This Tutorial can walk you through some of HyperSnap's basic steps and many options available to you. It
assumes you are familiar with Windows 95 and its basic operations.

Text Highlighted and Underlined like this is hyperlinked to further information about the topic. When you 
see text like this, if you are interested in that particular section, you should click it for further details.

The best way to learn is by doing. Try the exercises using HyperSnap; you will benefit from the 
experience. You can print this tutorial by clicking on this text; you may find it easier to follow.

1. HyperSnap offers three types of screen captures. You should first decide which will be best for
the task at hand.

Full Screen captures the 
entire screen.

Window is a very flexible and 
convenient method where 
HyperSnap outlines screen 
sections, like windows, 
automatically, making them 
easy to capture.

Region lets you outline any 
screen area that you need to 
capture.

 No matter what you select, you can always use HyperSnap's crop function to further edit your capture.

2. In order to view HyperSnap and your capture after it has been done, make sure that the 
Restore After Capture option under the Capture menu is checked. If it is not checked, HyperSnap will
be minimized (go to the task bar) and you will have to click on it to open it up again. It's not a big deal, but
now you know what that option does.

3. Let's try a capture using the Window capture option. We will need a target application to capture 
so Click here to open Windows Explorer or, for NT users, File Manager,    if one of them isn't already open.
If HyperSnap isn't already open, Click here to open HyperSnap.

4. Read all these bulleted steps before you proceed with the capture so you can follow them 
without referring to this file. You can optionally print this tutorial by clicking here if you haven't already.

When you are ready to begin, make sure that HyperSnap is the top-most window; Windows Explorer 
should be directly beneath. Whatever window or area you want to capture should always be visible.

Next, you will select Window from beneath the Capture menu and click on it. HyperSnap will 
disappear, out of your way, down to the taskbar.

Your cursor will have turned into a little plus sign (+). Move it around, to different sections of the 
Explorer window. As you move it, notice that the blinking highlighted areas change. If you move to 
the Title Bar, the whole window is highlighted -- take your time and see all your options. Do you 
notice depending on where you move in the file windows you can include or exclude the sliding bar?

Once you have highlighted an area you want to continue to experiment with, click your left (primary) 
mouse button.

 You can also use HotKeys to initiate your captures. We'll talk about that at the end of this Tutorial.

5. After HyperSnap takes the screen shot, it's program window, with your capture, will be restored to 
your view. You can change HyperSnap's window size like any other program if you want to see more of 



the capture.

6. At this point, if you were satisfied with the capture, you could save it or do other things with it, but let's 
try the handy crop feature first. Cropping lets you edit your capture further by selecting an area within it
to keep, while discarding the rest. Like before, read all these bulleted steps before you proceed with the 
capture so you can follow them without referring to this file:

The first thing you will do is click on Crop from the Edit menu. Your cursor will again turn into a little 
plus sign (+); notice how the coordinates of your position are displayed in the program's title bar 
above. 

Now, Move it to the location that you will want as one corner of the section of the capture that you 
want to save and click your left mouse button. That will anchor one corner of the area you will crop 
from the capture.

Continue to move around, experiment with all that you can do. Without touching a mouse button, 
strike the minus or dash (-) key. Now, you can see the size, in pixels, that the cropped area will be. 
Hitting the key again will make the size go away. Pressing the F1 key will show you all the other 
options at your fingertips; you can click here for further crop information right now if you want more 
details on the function, or wait until later.

Now, move your cursor to enclose the area that you want to remain, and click your left mouse button.
The capture is cropped per your specifications.

If you choose Undo Crop from the Edit menu, it will undo the action and restore your original capture.

 The Region Capture action, when you select it, works very similarly except it affects the whole screen. 
Now you have experience with how that method of capture works, too.

7. Now it's time to save your capture. As before, read all these bulleted steps before you proceed with
the capture so you can follow them without referring to this file.

First, click on the Save As selection under the File menu to get a familiar-looking dialog. 

Now, click on the Save file as type: arrow. You can select from Bitmap (BMP), GIF, or JPEG (JPG) 
Pictures (file types). Choose Bitmap

Click on the Options button in this dialog. You are presented with a dialog that offers different options
for saving the file. Click on the Help button, and an explanation for these options is provided for your 
reference.

You may want to take a moment to choose first GIF and then JPEG from the Save As dialog, and 
check the options available for each of them. Again, help is only a click away.

Once you have chosen your file type and options, use the usual means of filling in a file name and 
navigating to the folder in which you want to save it, and click OK. Your capture is now saved.

 You can also copy your capture to the Windows Clipboard, and by using the Copy Format selection 
under the Edit menu item, you can choose the color density of the image that is copied.

8. You have completed this Tutorial, but HyperSnap has more ways of operating and features for your 
use. The QuickHelp image map that shows all of the HyperSnap menu items is a great way to learn about
them. Just click on each menu item for an explanation.

Here are more topics that you will find of interest:



Hotkeys can also be used to initiate a capture. 

HyperSnap can be minimized to the taskbar, and out of your way, but it's always ready to spring into 
action.

Click on the Capture Menu item. Note the hotkey combinations assigned to each of the three types of 
captures. If you strike any of those combinations while HyperSnap is minimized, it will become active and 
capture the screen using the method you selected.

You can change the hotkey assignments to ones that you prefer by selecting Configure Hot Keys from 
the Options menu item.

Did you know that HyperSnap can be used as a handy graphics tool?

Use the Open selection from the File menu item to load any BMP, GIF, or JPG file into HyperSnap. Now 
you can...

Convert from one file format to another using the Save As selection under the File menu item, 
using all of the options available for each format. Yes -- that means you can convert a standard 
BMP file to a progressive JPEG or a GIF with a transparent background!
Copy the graphic to the Windows Clipboard in the number of colors you select.

Crop the graphic to just the right size -- HyperSnap can even show you the area's size in pixels 
as you make your selection. Use the crop feature and press the (-) key.

See Also...
 Include Cursor Image
 Quick Save
 Quick Print
 Quick Copy



 HyperSnap    Tips and Hints

This section includes good ideas on how to approach certain captures using HyperSnap. Do you 
have a unique solution for a problem using HyperSnap. Help your fellow users -- send it to the author for 
use in the next release's hints and tips section.

How can you capture a drop-down menu or other program feature that disappears when you press
the HyperSnap hot key or menu item?

Press the Print Screen key on your keyboard to send the entire desktop to the Windows 
Clipboard. Now, place the shot in HyperSnap by using the Edit|Paste menu selection. Using the 
Crop feature will let you select

You can take and use captures with HyperSnap without ever seeing the program! Maybe this 
technique or a variation will be helpful to you.

Set HyperSnap's options to Quick Copy from the Capture menu, and check off Restore after 
capture under the same menu item. Now, go to your word processor or other application and 
proceed with your work. When you need a capture, use the appropriate HyperSnap hot key. The 
options selected will cause the capture to be sent to the Windows Clipboard, so you can simply 
paste it into your document.

 If you need a reminder for which hot key to press, click on HyperSnap in the task bar with your right 
mouse button, and select the type of capture you want.



 HyperSnap    a Beta-Test Story
When I was developing HyperSnap ver. 2.60, I had two reports from the users of previous versions that 
sometimes GIF pictures saved from the program were scrambled. I tried to reproduce the problem to fix it,
but could not. I finally decided that something could be wrong with the computers of these two persons 
who reported it. After all, thousands of others were using HyperSnap ver. 2.55 and earlier, and nobody 
else had such troubles.

Then Chris Gleason volunteered to beta-test HyperSnap 2.60. He was the third one to observe the 
problem. He sent me a bunch of pictures drawn by his friend - cartoonist Steve Troop (creator of The 
Adventures of Mayberry Melonpool, see http://www.users.cts.com/sd/m/mlnpool). Without much hope I 
set out to capture their faces with HyperSnap. Hosanna! It worked! The cartoon character named Zed 
was particularly elusive. I was getting all kinds of scrambled pictures. It took at least two days to check 
and double check the GIF file saving code to find a really nasty bug. HyperSnap worked well for me after I
terminated the bug, so I sent a new beta to Chris. Guess what came back? A picture of Zed, almost 
perfect, but with an added feature of three-days’-growth of beard! I was laughing that Zed decided for 
himself how to improve his looks. This time it took only an hour or so to find and fix another bug. Here is 
the same story told from Chris’s point of view. He made it much more colorful, after all he is a writer…

Greg Kochaniak

Chris: Come and listen to a story 'bout a man named Zed. . . .
A little over a month ago, in a faraway land known as Junebug County, USA, a strange country 

bumpkin named Zed sat on his porch minding his own business. Simple living, that’s what Zed liked 
— sitting on his porch, rocking in his chair, smoking a cigar, petting his lazy bluetick hound Roscoe.    
He wasn’t much of one for new-fangled, whizbang gadgets like cameras.    So, when a city boy by the 
name of Chris came by one day to take his picture, he was understandably upset.    He chewed his 
cigar nervously and confronted the city-slicker.

“What you wanna go and take my ugly pitcher fer, son,” Zed asked. “You go on back ta Californee 
and mind yer own dern bidness!    Leave me alone!”

“I represent Steve Troop, the guy who draws you,” replied Chris.    “He wants to make set of web 
pages out of his cartoon characters, and you’re one of them!”

Zed looked confused for a second.    He thought webs were something “Black Widders” made out in
the henhouse.

“I dasn’t care if yer the King of China!    You ain’t gonna take my pitcher,” yelled Zed.    “Just ’cause 
I’m a cartoon character don’t make me no less of a man!”

Chris, undaunted by the stubbornness of this doodled simpleton, reached up with his copy of 
HyperSnap (registered — only $20!) and took a quick picture of Zed’s glowering face before running 
back home.



Much to his chagrin, when Chris opened up the picture he had taken of the surly Zed, it was a 
scrambled mess!

“What’s going on,” Chris thought.    “What kind of deviltry is this?    Why can’t this cartoon-
man be photographed?”

Chris told Greg Kochaniak, the Mighty Wizard who created HyperSnap, his tale of woe regarding Zed and
the scrambled picture, and sent him a copy of the picture.    Greg took a look at the picture, then peered 
inside the HyperSnap case and pondered the problem.    He had heard of people’s pictures getting 
scrambled like this, but had never been able to find a subject whose picture he could scramble on his 
own.    Mighty Wizard though he was, he never had been able to recite the incantation which produced 
this spell.

After many days of looking over the problem, the Mighty Wizard Greg thought he had found the 
correct words, and spake them over HyperSnap.    Bestowing upon Chris this new version, he ordered
Chris to face Zed once again and try to take his picture.

When Chris arrived back at Zed’s porch, he approached the hillbilly slowly.    He didn’t want to upset
him any more than he had to.

Zed puffed at a cheap cigar and chuckled at Chris.

“Hee, hee, hee. . . .    Looky here, Roscoe. . . that so-‘n’-so with the cam’ra is back,” said Zed.    
Roscoe looked up at Chris with sleepy eyes, perhaps thinking that in his puppyhood he would have 
showed this good-for-nothing city-slicker something about real country hospitality.    However, Roscoe 
just yawned and chewed at a flea that wasn’t there.

Zed then addressed Chris directly: “Didn’t yer mama ever teach ya any manners?”

Chris shook off Zed’s icy salutation, showed him the bad picture, and asked Zed if he could try to 
take his picture again.    The bumpkin just laughed.

“Hahahaha!    I tol’ ya ya couldn’t take my pitcher, ya dern fool!    I tell ya, all that fancy-shmancy 
gadgetry ain’t nothin’ but bunk,” said Zed.

“But this camera is better,” protested Chris.    “Look!    It’s all new and shiny!    And magical, too!    I 
bet it’ll take a really good picture of you!”

Zed thought for a second and said, “You’re on, city boy!    Ain’t never been a pitcher of me before, 
and there ain’t never gonna be none of me ever!    Pffft!    Magical cam’ras. . .    Bunk!”

Chris, feeling smug now that he had the new, magical HyperSnap, held it to his eyes and took 



another shot of Zed, who again glowered at the camera.

Chris raced home at top speed to develop the new picture of Zed.    When he took a look at it, he 
saw Zed’s frowning visage. . . but not quite.

“Hmmm,” he thought.    “Why does Zed have a beard?”
The answer was simple — the magic camera messed up again.

Chris once again went to visit the Mighty Wizard Greg, and showed him the bearded picture of Zed.

“My, this is curious,” said Greg, who walked away, taking the HyperSnap camera with him.    Greg 
brought the camera into his spell room and opened it up again.    He looked and looked and looked 
again, finding nothing.    He then looked in his spell-book to make sure he had recited the previous 
incantation correctly. . . and found that he had mis-spoken a word!    “Of course,” exclaimed Greg. “It’s 
‘sargentabilko,’ not ‘scmodsakabalto!’”

He quickly recited the correct incantation and handed the magic camera back to Chris.

Chris knew what he had to do. . . .

When Chris arrived back at Zed’s porch, Zed was sitting in his regular rocker, chewing another 
stinky cigar and sipping a lemonade.    Roscoe was hiding under the porch, staying out of the heat.    
When Zed saw who was coming, he jumped off the chair and ran to meet the silly city-slicker who 
insisted on taking his picture.

“So, city boy,” said Zed contemptuously, blowing a cloud of smoke in Chris’ face.    “Ya gonna take 
my pitcher again?    What is it this time?    My head on backw’rds?    Did I suddenly grow a hunnert 
eyes?!?    Hahahahaha!!!”

Zed was fairly laughing himself to death by now.    Chris just hoisted the magic camera to his face 
and took aim.    Zed saw this and put on his trademark glower.

“Don’t you dare, city boy!    Nobody takes my pitcher without. . .” <*CLICK*>

Chris took his camera and bolted, with Zed following close at hand.    The only thing that saved the 
out-of-shape Chris was that Zed winded easily from smoking so many cigars.

Chris took HyperSnap back to his computer and developed the picture and. . . SUCCESS!    He had
captured the elusive Zed for the web pages!

 Chris told the Mighty Wizard Greg his story of how he caught Zed on film, and Greg 
rewarded him with a forum by which to tell the whole world about the web pages his friend Steve wanted 
to publish.



The moral of the story: Don’t smoke.

Zed, Mayberry Melonpool and all associated characters are (c) and TM 1996 by Steve Troop 
(http://www.users.cts.com/sd/m/mlnpool)    All rights reserved.    

The accompanying story is (c) 1996 by Chris Gleason (http://www.meals-on-wheels.org/cgleason.html).    All rights reserved.




